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Up & Running 
Getting o2c_Interactive! up and running is a simple matter with 
its flexible and interactive setup program. Use the "System 
Requirements" and "Pre-Installation Checklist" in this chapter 
to make sure you're ready to begin installing the program. The 
setup instructions that follow take you step-by-step through the 
installation process.  

To get the most from this manual, please refer to “How to Use 
This Manual” in this chapter.  

DATACAD LLC offers 30 days of free installation support 
when you purchase o2c_Interactive!. If you have any questions 
about installing o2c_Interactive!, you can contact DATACAD 
LLC Technical Support Monday through Friday, 8:00 a.m. – 
5:00 p.m. eastern time, except during normally observed 
holidays, via phone at (860) 677-2829, via fax at (860) 677-2883, 
or via e-mail at techsupport@datacad.com. 

 

1 
In this chapter: 

 How to use this 
manual 
 System requirements 
 Pre-installation 

checklist 
 Installing 

o2c_Interactive! 

 



| CHAPTER 1: UP & RUNNING  4 

How to Use This Manual 
This manual introduces o2c_Interactive! to you. Once you understand how 
o2c_Interactive! works, you can apply the principles to your own projects. 

The manual gives detailed explanations as well as step-by-step instructions on 
how to use each o2c_Interactive! function and menu to create different design 
schemes, save custom views, and develop your presentation. These instructions 
may include using keyboard shortcuts, selecting entities or objects, and choosing 
menu options. 

Words or characters to be typed are printed in bold; type them exactly as they 
appear. Keys to be pressed are shown just as they appear on your keyboard, with 
parentheses around the character(s), as shown below: 

Press [Enter]. 

Press [Ctrl] + [O]. 

Combinations like the second example above should be executed by pressing 
and holding down the first key, pressing the second key, then releasing both 
simultaneously. 

Some instructions ask you to "click," "right-click," or “[Ctrl] + right-click” on a 
button, icon, or entity. To click on a button, move your mouse until your cursor 
arrow is over the button and then press the left mouse button once. To right-
click, press the right mouse button once. To [Ctrl] + right-click, move your mouse 
until the cursor is over the button and press the [Ctrl] key at the same time you 
press the right mouse button. Right-clicking and [Ctrl] + right-clicking generally 
don't require specific placement of the cursor; however, it must be somewhere 
over the o2c_Interactive! window.  

Getting Help in o2c_Interactive! 
Help is easily accessible by pressing [F1] or by selecting o2c_Interactive! 
Reference Manual from the Help Menu in o2c_Interactive!. The reference manual 
is a PDF file that opens within the Adobe Acrobat Reader program. If you do not 
have the Adobe Acrobat Reader program on your computer already, 
o2c_Interactive! will try to redirect you to the Adobe website where you can 
download and install the freely distributable Acrobat Reader. 

Installing o2c_Interactive! 
To install o2c_Interactive! on your computer, first review the "System 
Requirements" and "Pre-Installation Checklist" sections below to make sure you 
have everything you need to install the program. Then follow the instructions in 
"Running the Setup Program" on the next page. 

Information in this section requires you to be familiar with your computer 
hardware and your computer's operating system (Microsoft Windows 
95/98/ME or Windows NT/2000/XP). 
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To check available free hard disk space prior to installation, double-click on the 
My Computer icon on your Windows desktop. Right-click on the drive you want 
to install o2c_Interactive! on and select Properties. The hard disk space already in 
use will be displayed as well as the amount that is still free. 

System Requirements 
Make sure you have the following minimum requirements to install and run 
o2c_Interactive! for Windows: 

• Personal or multimedia computer with a Pentium-based processor (Pentium 
II or faster recommended) 

• Windows 95 or later or Windows NT 4.0 or later (Windows 98 or later 
recommended) 

• 64MB of memory for use on Windows 95/98/ME (128MB recommended); 
128MB for use on Windows NT/2000/XP (256MB recommended) 

• Minimum of 20MB free hard disk space for program installation. 

To check available free hard disk space prior to installation, double-click on the My 
Computer icon on your Windows desktop. Right-click on the drive you want to install 
o2c_Interactive! on, and select Properties. The hard disk space already in use will be 
displayed as well as the amount that is still free. 

• CD-ROM drive (if installing from a CD-ROM) 

• SVGA (800x600), or better, resolution graphics card capable of displaying 16-
bit color or better (3D hardware acceleration with support for DirectX7 or 
later recommended)  

• Microsoft-compatible mouse or digitizer  

Pre-installation Checklist 
• Do you have the minimum system requirements for o2c_Interactive!? 

• Where do you want to install o2c_Interactive!? If you’re upgrading your 
current version of o2c_Interactive!, install the new version to the same drive 
and folder so that the program is properly updated. 

• If you’re upgrading your current version of o2c_Interactive!, have you made 
a copy of your o2c_Interactive! folder to back up all your files before 
installing the new version? This is simply a precaution against losing any of 
your files. 

• Remember to fill out and send in your registration card or register online to 
qualify for technical support benefits and to receive new product information 
as it becomes available. 
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Running the Setup Program 
The o2c_Interactive! setup program guides you step-by-step through installing 
o2c_Interactive!. Please exit all Windows applications completely before running 
the o2c_Interactive! setup program. 

 To install o2c_Interactive! on your computer: 

1. Place the o2c_Interactive! CD-ROM in your CD-ROM drive; the setup 
program should start automatically. If it doesn’t, click on Run in the Start 
menu. In the Open input box, type e:\setup, where “e” is the letter of 
your CD-ROM drive. Press [Enter] or click on OK. To cancel the 
installation at any time, press [Esc] or click Cancel. 

Or follow the instructions on your screen to install the download version 
of o2c_Interactive!. 

2. The setup program begins. Simply follow the instructions on the screen. 
To properly update your current version of o2c_Interactive!, install this 
new version to the same folder. 

3. Once setup is complete, you can view the ReadMe file, which contains 
important information about o2c_Interactive! that is not documented 
anywhere else. Click Finish to complete the setup program and open the 
ReadMe file. 

The setup program will ask you to enter your serial number. If you purchased 
o2c_Interactive! on CD-ROM, your serial number is printed on your registration 
card. If you received o2c_Interactive! as an Internet-deliverable, your serial 
number is the same as your invoice number. Be sure not to substitute the letter 
“O” for a zero when entering your serial number. 

 



 

The Design Board 
Think of your o2c_Interactive! screen as a stage where you can 
create a wide variety of design schemes. You will quickly learn 
how to take full advantage of the pull-down menu options, the 
icons, and the browsers to develop design alternatives. 
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Starting o2c_Interactive! 
There are two ways to start o2c_Interactive! You can: 

• Double-click on the o2c_Interactive! icon on your computer’s desktop.  

or 

• Use the Start menu. 

 To use the Start menu to open o2c_Interactive!: 

1. Click on the Start button in the lower left corner of your screen. 

2. Select Programs to display the list of the software available on your 
computer. 

3. Scroll to o2c_Interactive! in the program listing to display the submenu 
options. 

4. Click on o2c_Interactive! The o2c_Interactive! program is ready to help 
you develop design alternatives. 

 
Figure 2.1: The o2c_Interactive! opening screen 

If o2c_Interactive! does not start, review Chapter 1 to make sure you meet all 
system requirements. You have 30 days of free installation support; see the first 
page of Chapter 1 for details on how to contact us.  
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Opening a Design File 
o2c_Interactive! allows you to work with files of three-dimensional objects, 
buildings, or designs that have either an .o2c or .aco suffix. There are two ways to 
open a design file in o2c_Interactive!: 

• Select Re-Open from the File pull-down menu, highlight the appropriate file, 
and click or press [Enter]. 

or 

• Select Open from the File pull-down menu to begin working with a new file. 
You can also use the [Ctrl]+[O] keyboard shortcut to open a new file. The 
Load Object dialog box appears. Highlight the appropriate file and click on 
Open or press [Enter]. 

 
Figure 2.2: The Load Object dialog box 

The file you load must have an .o2c or .aco suffix. For example, you could use a 
file called 3D_Kitchen.o2c or LAMP06.aco to load a three-dimensional room or 
an object. If there is a check in the Show Preview box, you will see a thumbnail 
sketch of the object before you load it into the player window. You can click on 
the preview object and rotate it with your mouse to see it from a different angle. 

Use the Look in drop-down box or the Up One Level icon to find folders that 
contain the objects you want to experiment with using o2c_Interactive! the Files 
of type drop-down box offers the suffixes for o2c Objects (*.o2c) or ArCon 
Objects (*.aco). You can also use the icons in the left panel of the Load Object 
dialog box to help you search for the appropriate file based on when you last 
used it (the History icon) or where it is stored (the icons for Desktop, Documents, 
various drives on your computer, or Network). In the Load Object dialog box 
above, the computer’s name is either My Computer (the Windows default) or 
whatever your system administrator decided to call it. This particular computer 
was named “Thing”; therefore, the fourth icon in the left panel is also called 
Thing. 
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If only a portion of the entire object you loaded in the Player Window is visible, 
you can use the Views pull-down menu and select Plan, Elevation (further 
divided into Front, Back, Right, and Left), Isometric, and Axonometric. 
Alternatively, you can click on the toolbar options to switch between parallel and 
perspective views or one of the other View icons. 

A Brief Tour of the o2c_Interactive! Screen 
The o2c_Interactive! screen has several parts. These include the Title Bar, Pull-
down Menu Bar, and Icon Toolbar along the top of the screen. An Information 
Toolbar, at the bottom of the screen, contains more details about the object your 
cursor is currently highlighting. 

The rest of the screen is divided into five parts. The contents of the file you 
opened are displayed in the Player Window. The Views/Schemes Browser in the 
upper left corner displays available saved views and schemes associated with the 
object. The Material Browser in the lower left corner shows the active list of 
materials. The Material Properties Browser in the upper right corner gives you 
maximum control over the object(s) in the Player Window. Finally, the Material 
Color Picker lets you experiment with a broad spectrum of shades and hues for 
the object(s) in the Player Window. 

Technically, the Views/Schemes Browser, the Material Browser, the Material 
Properties Box, and the Color Picker are toolbars. You can leave these four 
toolbars docked on either side of the Player Window. If you prefer, you can 
undock them and position them anywhere within the Player Window.  

 

 

Pull-down Menu Bar Icon Toolbar 

Title Bar 

Player 
Window 

Color 
Picker 

Material 
Properties 
Browser 

Information
Toolbar 

Material 
Browser 

Views and 
Schemes 
Browser 

Figure 2.3: The o2c_Interactive! screen is divided into several parts. 

You use the options from the pull-down Menu Bar, the Icon Toolbar, the Views 
and Schemes Browser, the Material Browser, the Material Properties Browser, 
and the Color Picker to control the appearance of the object(s) in the Player 
Window. 
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Pull-down Menu Bar 
The pull-down Menu Bar is located along the top of the o2c_Interactive! screen 
and contains the File, Edit, View, Scheme, and Help pull-down menus. These 
menus give you quick access to many of o2c_Interactive!’s most frequently used 
features. 

Notice that some menu options have keyboard shortcuts associated with them. 
For instance, the Open option in the File menu has [Ctrl]+[O]. Instead of using the 
mouse to choose a menu option, you can simply press the keyboard shortcut to 
quickly do the same thing. 

 To choose an option from the Pull-down Menu Bar: 

1. Click on the menu name in the pull-down Menu Bar. The menu will drop 
down, displaying all the options in it. 

2. Move your mouse down the menu to the option you want. Notice that 
each option highlights as your mouse passes over it. 

3. Click on the option you want to select. 

Toolbars 
There are eight toolbars in the o2c_Interactive! program: Standard, Views, Lights, 
Views/Schemes Browser, Material Browser, Material Properties, Color Picker, 
and Information. The Standard, Views, and Lights toolbars contain icons that 
you can click on to perform different tasks. The Views/Schemes Browser, 
Material Browser, Material Properties, and Color Picker toolbars are larger 
rectangular boxes. You can resize the box-shaped toolbars, except for the 
Material Properties one. 

You control which toolbars appear on your screen via the Toolbars option in the 
File pull-down menu. Only the toolbars that are preceded by a checkmark will 
appear on your screen.  

You can either dock (the default) these toolbars around the perimeter of the 
Player Window or undock them to reposition them where it is most convenient 
for your purposes. 

 To reposition a docked toolbar: 

1. Use the left mouse button to find the bar located at the left edge 
(Standard, Views, Lights, and Information toolbars) or top (Material 
Browser, Material Properties, Color Picker, and Views/Schemes Browser 
toolbars). The cursor will change to a four-direction arrow when it is 
positioned on the bar. 

2. Click on the bar and keep the left mouse button depressed. 

3. Drag the toolbar to a new position around the perimeter of the 
o2c_Interactive! screen. 
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 To undock a toolbar: 

1. Use the left mouse button to find the bar located at the left edge 
(Standard, Views, Lights, and Information toolbars) or top (Material 
Browser, Material Properties, Color Picker, and Views/Schemes Browser 
toolbars). The cursor will change to a four-direction arrow when it is 
positioned on the bar. 

2. Click on the bar and keep the left mouse button depressed. 

3. Drag the toolbar to a new position anywhere in your Player Window. 
When a toolbar is undocked, its name will be displayed in a title bar. 

 To dock an undocked toolbar: 

1. Click on the undocked toolbar’s title bar and keep the left mouse button 
depressed. 

2. Drag the toolbar to where you want to dock it around the perimeter of 
your Player Window. You’ll know you have successfully docked the 
toolbar when its name disappears from the title bar and a blank bar 
appears along its left edge or top. 

You can double-click on the title bar of any toolbar to quickly return it to its 
previous undocked or docked position. 

Notice that the docked toolbars assume the width and height of their undocked 
shapes. If more than one toolbar is docked at the side of the Player Window, they 
will all take on the width of the toolbar that was widest in its undocked form. 
You can change the shape of the Material Browser, Color Picker, and 
Views/Schemes Browser toolbars; however, you cannot change the width or 
height of the Material Properties toolbar.  

You may place these four toolbars on one side of the Player Window, on both 
sides of it, or hide one or more of them. For example, to hide the Color Picker 
toolbar, you could select Toolbars from the File pull-down menu and make sure 
there is no check in the Color Picker box. 

Although the Material Browser, Color Picker, Views/Schemes Browser, and 
Material Properties boxes are technically toolbars, o2c_Interactive! calls them 
“browsers” because they offer many more options that you can directly control 
than do the icon toolbars. 

Icon Toolbar 
Below the Pull-down Menu Bar, you can display the icons that will help you 
control your project. A list of the toolbars and browsers that are available is in 
the File pull-down menu. You can display the toolbars and browsers that you 
find most useful and hide those that you rarely use. You can arrange the three 
toolbar icon groups in any configuration that you want. If you turn off all the 
toolbars and browsers, your design project fills the entire screen below the Pull-
down Menu Bar. 

There are three toolbars of icons that you can display below the Pull-down Menu 
Bar: 
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• Standard This toolbar contains the traditional Windows file open, save, 
copy, paste, and undo/redo icons. In addition, there is a Reset 
icon that restores the material properties that existed before you 
edited them with the Material Properties Browser. You also 

have two cursor options: navigate  and select . The 
navigate cursor allows you to rotate and reposition the design in 
your Player Window. The select cursor allows you to highlight 
the portion of your design that you want to change by using 
o2c_Interactive!’s many features. 

• Views This toolbar displays the icons that control the view of your 
design project. You can switch between parallel and perspective 
view, rotate clockwise or counterclockwise around the Z axis, 
and increase or decrease your field of vision. You can use the 
icons to switch among plan, elevation, isometric, and 
axonometric views of your project. The final icon lets you 
preview a raytraced rendering of your design. 

• Lights This toolbar controls the lighting. You can toggle these lights on 
or off. You can switch sunlight on or off, control three ambient 
light sources, use lamps, or toggle between day and night 
lighting. 

 Standard group Views group Lights group 

 
Figure 2.4: Icon toolbar groups can be rearranged to suit your needs. 

Information Toolbar 
The Information Toolbar describes the color and other properties of the object 
that you touch with your selection cursor. You can turn the Information Toolbar 
on and off through the File pull-down menu.  

 
Figure 2.5: The Information Toolbar  

Browsers 
Although technically toolbars, the Views/Schemes Browser, Material Browser,  
Material Properties, and Color Picker are collectively called “browsers.” 

Views/Schemes Browser 
You can display or hide the Views/Schemes Browser box and position it 
anywhere in your Player Window. Switching between different views and 
schemes is easily accomplished with a click of the mouse. 
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Figure 2.6: The Views/Schemes Browser 

Material Browser 
In the Material Browser, you can see the colors and properties associated with 
the various objects within your design project. The four icons within this browser 
control what appears in the browser’s list of objects that are included in your 
design project. From left to right, the icons are: 

• Object Material list 

• Available material definitions 

• Available bitmap textures 

• 255-color custom palette 

 
Figure 2.7: The Material Browser 

You can place the Material Browser anywhere on your screen. 
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Material Properties Browser 
You can fine-tune a selected material’s properties and its rendered display. The 
five slider bars let you control how the object is affected by light and various 
conditions. There are five check boxes that further control illumination, 
rendering, and textures. The textures check boxes are not available if the surface 
cannot accept a texture. The Matte, Glossy, and Glass buttons automatically 
apply predetermined properties to a given object. 

 
Figure 2.8: The Material Properties control box 

You can place the Material Properties browser anywhere on your screen. 

Color Picker 
You can control the new color of the selected object in your design project by 
clicking on the cube, using the hue slider bar, or entering new values in the hue, 
saturation, and brightness control boxes. On the bottom of the Color Browser, 
you can compare the new color to the original one. Right-click and drag to spin 
the color cube. 

  

Brightness slider barColor cube 

Old/new reflection 
color 

Red, green, blue values 
Old/new diffuse color 

Figure 2.9: The Color Picker 

 

 

  





 

Establishing Views 
Views and schemes are important parts of developing your 
presentation using o2c_Interactive!. At first, you can develop 
several alternative views of your design project.  
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Working with Views  
o2c_Interactive! lets you develop and save a variety of views. Views affect the 
position of the design project displayed in the Player Window. When you work 
with views, you will be using mainly the View pull-down menu, the Views 
Toolbar, and the Views/Schemes Browser.  

You will be able to associate different design schemes with each view. Then, you 
will use the Views/Schemes Browser to recall your schemes and present them 
from different vantage points. 

There are many ways to change the view of the design project displayed in your 
o2c_Interactive! Player Window. You can use the options available through the 
View pull-down menu or you can click on one or more of the icons on your 
toolbar. After you establish a new view of the design project, you can save or 
modify it. 

Let’s explore some of the options in the view arsenal. 

The Navigation Cursor Changes Views 
In the Standard Toolbar, the navigation cursor looks like an anchor. This special 
cursor lets you dynamically change the view of the design project. 

 To use the navigation cursor to change views: 

1. Open a design project that was stored as an .o2c or .aco file. In this case, 
we are using the Kitchen.o2c file that was developed with the DataCAD 
architectural program. 

2. Click on the navigation cursor in the Icon Toolbar. Your cursor now looks 
like an anchor. 

3. Position the navigation cursor within the Player Window and use it to 
dynamically change the position or magnification of the design project. 

• Hold down the left mouse button while you drag to the left, to the 
right, up, down, clockwise, or counterclockwise on your mouse pad. 
Notice how your view changes. You can even flip the design upside 
down! 

• Hold down the right mouse button and drag downward (toward 
yourself) on your mouse pad. Notice that the cursor now looks like a 
magnifying glass. This magnifies (or increases the size of) the design 
project in your Player Window. 

• Hold down the right mouse button and push upward (away from 
yourself) on your mouse pad. Notice that the cursor now looks like a 
magnifying glass. This minimizes (or decreases the size of) the design 
project in your Player Window. 

4. Release the mouse button when you are satisfied with the view. 

You can also change the view without using the mouse. Just tap the [Arrow] keys 
to control left, right, up, and down movements in your Player Window. 
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Using the Icons in the Views Toolbar 
You can click on the icons in the Views Toolbar to change the way you see the 
current design project. Each icon or grouping has a different effect on the view 
that is displayed in the Player Window: 

• Parallel/perspective Switches between these two view types 

• Rotate clockwise 

• Rotate counterclockwise 

• Fields of view Two icons decrease or increase the field of view 

• Plan Toggles on the orthographic or plan view 

• Elevations Select right, left, front, or back elevation view 

• Isometric Show the isometric view 

• Axonometric Display the axonometric view 

• Raytrace Render with shadows and reflections 

 

 

  

 
 

 

Figure 3.1: The Views Toolbar icons 

Switch to 
parallel or 
perspective
view 

Decrease or increase the 
field of view 

Rotate clockwise or counter- 
clockwise around the Z axis Plan view 

Elevation views 

Raytrace

Axonometric view 

Isometric view 

Saving, Displaying, and Switching Views 
It is easy to save each view, display the one you want to work with, and switch 
among several views. Views are saved on your computer with a .gtv suffix. 

 To save the view that is currently displayed in the Player Window: 

1. Select Add View from the View pull-down menu. The Add View dialog 
box appears. 

 
Figure 3.2: The Add View dialog box 
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2. Type a meaningful name for the view in the input box. Use only the 
upper- or lower-case letters, the numbers 0 through 9, and/or spaces for 
the view name. Do not use any punctuation marks. 

3. Press [Enter] or click on OK. 

 To save the changes you made to a view: 

1. Select a view and make the changes you want. 

2. Select Update View from the View pull-down menu. The Update View 
dialog box appears. 

3. Click on the drop-down arrow to display the names of the views you 
created for this design project.  

4. Select one of those views and press [Enter] or click on OK. 

 
Figure 3.3: Select the name of the view you want to update. 

 To display the list of views you created and named, you can either: 

• Click on the [+] button next to Views in the Views/Schemes Browser. The 
names of the views appear in the Views/Schemes Browser. 

 
Figure 3.4: The views you created and named are displayed in the 
Views/Schemes Browser. 

Or 

• Select Views from the View pull-down menu. The names of the views 
appear in an extended menu. 
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 To switch from the current view to a different one, you can either: 

• Click on [+] beside Views to display saved views. Then, click on the name 
of the view you want in the Views portion of the Views/Schemes 
Browser. 

Or 

• Select Views from the View pull-down menu. Then select the name of the 
view you want to display from those listed in the extended menu. 

Changing the Background 
You can change the view by altering the background of the Player Window with 
a color or bitmap image. You can also select a different display mode. 

 To change the background color of the Player Window: 

1. Right-click within the Player Window. A menu appears. 

2. Select Background. The Background dialog box appears. 

 
Figure 3.5: Background dialog box 

3. Make sure the Monochrome option is activated. 

4. Click on the Select color . . . button. The Color palette dialog box appears. 

 
Figure 3.6: Color palette dialog box 



| CHAPTER 3: ESTABLISHING VIEWS  22 

5. Select a color from the options available or mix your own by clicking on 
the Define Custom Colors button to expand the dialog box. By clicking 
within the color window, using the slider bar, or typing numbers in the 
Hue, Saturation, Luminosity, Red, Green, and/or Blue input fields, you 
can fine-tune your selection. When you are satisfied with what appears in 
the larger swatch, you can click on the Add to Custom Colors button to 
transfer your mixture to the smaller custom color squares to the left. 

 
Figure 3.7: The expanded Color palette dialog box lets you create custom colors 
and add them to your background options. 

6. Choose the background color by highlighting the swatch from the Basic 
or Custom options on the left side of the expanded Color dialog box. 

7. Click on OK or press [Enter] to return to the Background dialog box. 

8. Click on OK or press [Enter] to leave the Background dialog box and 
activate your new background color. 

 To use a picture in the background of your Player Window: 

1. Right-click within the Player Window. A menu appears. 

2. Select Background. The Background dialog box appears. 

3. Click on the Load image button. The Load background image dialog box 
appears. Notice that you can use images that have .bmp or .jpg file 
suffixes. 
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Figure 3.8: Select a background image. 

4. Use the icons next to the Look in box to browse through folders that 
contain image files with an acceptable suffix. 

5. Highlight the file you want to use as a background image. The name 
appears in the File name input box. 

6. Click on Open or press [Enter]. The Background dialog box reappears. 
Notice that there are now three available options and that Background 
picture is highlighted. 

7. Click on OK or press [Enter]. The image you selected appears as a 
background in your Player Window. 

You can display several copies of the background image in tiles. Images that are 
not tiled are stretched to fit the entire width and height of the Player Window. 
The resolution need not be wider than 2,048 pixels because that is the maximum 
width allowed for rendered output. Tiled backgrounds are anchored to the 
upper-left corner of the Player Window. The X and Y offset values are relative to 
the upper-left corner of the Player Window. Since tiled backgrounds are not 
stretched to fit the Player Window, this option should be used when you 
superimpose your model over a digital photograph. 

 To display several copies of the selected background image in tiles: 

1. Select a background picture by following steps 1 through 6 of the 
previous procedure. 

2. Click in the circle beside Tiled background picture. The X and Y Offset 
input boxes are activated. (The X and Y offset is a value in pixels. So if 
you want to shift the origin or starting point of your bitmap tiles, you can. 
You have to consider the size in pixels of your background image and the 
size in pixels of the Player Window.) 

3. Type a value in the X input box and another value in the Y input box. The 
X option indicates the number of times the background picture should be 
repeated horizontally. The Y option indicates how often it should be 
repeated vertically. 
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Figure 3.9: The picture you selected will be tiled in the background of your design 
project in the Player Window. 

4. Click on OK or press [Enter]. The picture you selected is tiled as you 
indicated in the Background dialog box. 

 
Figure 3.10: Tiled images appear as a background for the design project in your 
Player Window. 

Changing the Display Mode 
Altogether, there are five display modes: wireframe, flat shaded, flat 
shaded/textured, shaded/textured, and wireframe hidden line removal. A 
checkmark precedes the name of the currently active display mode. The 
o2c_Interactive! default display mode is shaded/textured.  

The display mode is the global feature that affects the appearance of all your 
views. Switching to a different display mode changes the appearance of all the 
views you created because they assume the characteristics of the current (or 
checkmarked) mode.  

In some cases, it may be easier to show your client a design that uses a different 
display mode. For example, if you switch to wireframe/hidden line removal 
mode in one of your saved views, all the other views in your design project will 
be displayed in the same mode. Then switch back to the normal shaded/textured 
mode for regular o2c_Interactive! views. 
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 To change the display mode: 

1. Right-click within the Player Window. A menu appears. 

2. Select Display mode to reveal an extended menu with more options. 
Normally, o2c_Interactive! uses the Shaded/textured display mode. 

3. Click on the display mode you want. 

• Wireframe – shows colors, no surfaces or textures 

• Flat shaded – shows colors, no textures 

• Flat shaded/textured – shows colors and textures, no shading 

• Shaded/textured – shows colors and textures, with shading 

• Wireframe/hidden line – shows no colors or textures, just surfaces 
and edges 

In this example, we show the wireframe/hidden line view that contains 
no colors or textures. 

 
Figure 3.11: The Wireframe/hidden line display option of the kitchen 

4. Switch to another display mode (such as the default flat shaded/textured 
to take advantage of the o2c_Interactive! rendering capabilities). 

The Filter option causes the Player to smooth the edges of polygons to produce a 
higher-quality preview. However, this option slows performance, so it should be 
turned off. 

Using the Controlbars 
Controlbars can help you quickly navigate around the o2c_Interactive! screen. In 
addition to the normal sliding bars on the right and bottom Controlbars, there 
are four options in the lower right corner. 

 To display the Controlbars: 

1. Right-click anywhere within the Player Window. A menu appears. 
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2. Activate the Controlbars by clicking on the No controlbars option. When a 
checkmark appears in front of this option, the bars are not displayed; 
when there is no checkmark in front of this option, the bars are visible. 

 To use the Controlbars: 

• Move the slider bars to reposition the design in your Player Window. The 
slider bars and their associated “elevator” cars do not usually appear if 
the design is not enlarged. You can either click on and drag the slider bar 
to reposition the project dynamically or you can click on the [Arrow] 
buttons at either end of each slider bar to move the design incrementally 
left, right, up, or down. Using the [Arrow] buttons produces minimal 
changes, so most people don’t often bother with them. Clicking on a part 
of the Controlbar where there is no “elevator” car rapidly repositions the 
design. 

 
Figure 3.12: Controlbar buttons appear in the lower right corner. 

• Click on the [+] button in the lower left portion of the Controlbars to 
zoom in on the project in the Player Window. 

• Click on the [-] button in the lower left portion of the Controlbars to zoom 
out on the project in the Player Window. 

• Click on the [a] button in the lower left corner of the Controlbars to show 
the extents of the project in the Player Window. 

• Click on the [R] button in the lower left corner of the Controlbars to begin 
raytracing the project in the Player Window. This has the same effect as 
clicking on the Raytrace icon in the toolbar. 

 

 



 

Developing Schemes 
Views and schemes are important parts of developing your 
presentation using o2c_Interactive!. At first, you can create 
several views of your project. Then, you can create a variety of 
schemes that influence the appearance of various elements of 
your design. Finally, you can experiment by pairing different 
schemes with the views you developed to show your client a 
variety of design alternatives. 
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Working with Schemes 
o2c_Interactive! lets you develop and save a variety of schemes. Schemes affect 
the way colors, textures, and materials of different entities within your design 
project appear. You will be able to recall different schemes from each view. This 
gives your client a wealth of design alternatives to explore. 

When you are developing different design schemes, you will be using the 
Scheme pull-down menu, the Material Browser, the Material Properties Browser, 
and the Color Picker. Then, you will use the Views/Schemes Browser to see the 
effect your schemes have when they are applied to the saved views. 

When you first open a design project, the only thing that appears in the Schemes 
portion of the Views/Schemes Browser is <None>. After you develop several 
alternative schemes, simply click on <None> to return to the original state of 
your design project. The same list of alternatives appears when you select 
Schemes from the Scheme pull-down menu. 

 
Figure 4.1: The original state of your design is available when you click on <None> 
in the Views/Schemes Browser. 

Using the Material and Material Properties Browsers 
The Material Browser and the Material Properties Browsers are closely related. 

Material Browser 
The Material Browser’s built-in icon toolbar gives you quick access to options 
available from the Material Properties Browser and the Color Picker. If you make 
changes to the material properties of an object, but you don’t like the 
modifications, you can click on the Reset icon in the Standard toolbar to restore 
the object’s previous material properties. The Reset icon is greyed or unavailable 
if you have not changed an object’s material properties recently. 
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Figure 4.2: Parts of the Material Browser 

Let’s start building a new scheme for the kitchen. The first thing you should do is 
to give the new scheme a meaningful name. 

 To create and name a new scheme in the Views/Schemes Browser: 

1. Click on <None> in the Schemes portion of the Views/Schemes Browser. 
If the [+] button appears before Schemes, click it to display the list of 
available schemes for your project. <None> is the name of the original 
scheme developed from the 3D drawing.  

2. Develop the new scheme.  

3. Select Save As from the Scheme pull-down menu. The Save As Scheme 
dialog box appears.  

 
Figure 4.3: The Save As Scheme dialog box 

4. Type your name for the scheme in the input box. Use only the upper- or 
lower-case letters, the numbers 0 through 9, and/or spaces for the scheme 
name. Do not use any punctuation marks.  

5. Click OK or press [Enter]. Notice that the scheme’s name appears in the 
Schemes portion of the Views/Schemes Browser and at top of the 
Material Browser. Schemes are saved on your computer with the .msc 
suffix. 

Active list of materials 

Available material 
definitions 

255 color custom palette 

Available textures 

Name of this scheme 

Numbers correspond 
to layers in the original 
3D drawing 

Color associated with 
entities on a particular 
layer  

Texture associated with 
entities on a particular 
layer 



| CHAPTER 4: DEVELOPING SCHEMES  30 

After you make changes to the materials used in this scheme, you can use the 
Save option from the Scheme pull-down menu to update and save the changes to 
your scheme. 

When you scroll down to Schemes in the Scheme pull-down menu, a list of 
available schemes appears in an extended menu. This same list appears in the 
Schemes portion of the Views/Schemes Browser, so you can select a scheme 
from either listing.  

Supplying Material Names 
If you cannot relate to material numbers as easily as you can to words, you can 
name each one. 

 To give a name to a material: 

1. Make sure that you click on the first icon (shaped like a cube) in the 
Material Browser to show the active list of materials. 

2. Click on a material number within the Material Browser. Notice that the 
entities affected by this material are highlighted in the Player Window. 
(In the kitchen, the microwave, stove, and refrigerator were highlighted.) 

4. Place your cursor anywhere in the colored bar within the Material 
Browser and right-click. A menu appears beside the cursor. 

 
Figure 4.4: Right-click to reveal this menu within the Material Browser. 

5. Click on Edit Material Name. The Material Name dialog box appears. 

 
Figure 4.5: Supply a meaningful name for the material affected. 

6. Type a name in the input box. Use only the upper- or lower-case letters, 
the numbers 0 through 9, and/or spaces for the material name. Do not 
use any punctuation marks.  

7. Click on OK or press [Enter]. The name appears in the Material Browser’s 
list. 

8. Continue giving other materials meaningful names. 
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Figure 4.6: Names are applied to all the materials available in this project. 
Numbers 0013 through 0018 are lamps, but they contain no materials and have 
not been named. 

 To change a material’s name: 

1. Right-click on the name you want to change in the Material Browser’s list. 

2. Select Edit Material Name from the menu that appears beside the cursor. 
The old name is highlighted in the Material Name dialog box. 

3. Type a new name in the input box. Use only the upper- or lower-case 
letters, the numbers 0 through 9, and/or spaces for the material name. Do 
not use any punctuation marks. 

4. Click on OK or press [Enter]. The new name appears in the Material 
Browser’s list. 

 To clear a material’s name and leave it blank: 

1. Right-click on the name you want to eliminate. 

2. Select Clear Material Name from the menu that appears beside the cursor. 
The name disappears from the Material Browser’s list, but the index 
number remains. 

Using Pre-defined Materials 
In the Material Browser, clicking on the spherical icon displays a list of pre-
defined materials. The pre-defined materials have matte, glossy, or glass finishes. 
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 To work with the pre-defined finish for a given material: 

1. Display the materials list (make sure the first icon in the Material Browser 
is active). Then, highlight the item you want to change. Alternatively, you 
can click on the item you want to change in the Player Window to 
highlight the appropriate material in the Material Browser list. 

2. Click on the spherical icon (the second icon from the left in the Material 
Browser). Notice that two new icons appear below the first four. If the 
second icon is activated, options from all the materials are available from 
the subfolders. If you want to limit the materials, click on the single folder 
to display the Material Folder dialog box and make further decisions 
about the surface (choosing from Glass, Glossy, or Matte finishes) and the 
color you want for that object. Then, click OK or press [Enter]. A “list” of 
globes or spheres appears in the Material Browser. 

 
Figure 4.7: Material Folder dialog box 

3. Click on a globe to see how its properties affect the object(s) in your 
Player Window. Notice that the Information toolbar displays the name of 
the color. 

You can display either small or large globes in the Material Browser list. To 
display the small globes, right-click on one and select Small Previews from the 
pop-up menu. To display the large globes, right-click on one and select Large 
Previews from the pop-up menu. 
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Figure 4.8: Selecting the neon red globe from the Glossy options presented in the 
Material Browser affects the toekick and burners in the Player Window as well as 
the contents of the Material Properties Browser and the Color Picker. 

Applying Textures 
The third icon from the left in the Material Browser controls an object’s texture. 
Just as with the pre-defined materials, two file icons appear below the first four. 

 To apply a texture to an object in your Player Window: 

1. Display the materials list (make sure the first icon in the Material Browser 
is active) . Then, highlight the item you want to change. Alternatively, 
you can click on the item you want to change in the Player Window to 
highlight the appropriate material in the Material Browser list. You 
cannot change the texture of a material if there is no checkerboard button 
before its name in the Material Browser list. 

2. Click on the checkerboard icon (the third icon from the left in the Material 
Browser). Notice that two new icons appear below the first four. If the 
second icon is activated, options from all the textures are available from 
the subfolders. If you want to limit the textures, click on the single folder 
to display the Texture Folder dialog box, select the appropriate subfolder, 
and click OK or press [Enter]. A “list” of texture samples appears in the 
Material Browser. (Some subfolders contain only one texture sample 
while others contain several.) 
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Figure 4.9: Texture Folder dialog box. 

3. Click on a texture sample from the list of options in the Material Browser 
to see how it affects the objects in the Player Window. The texture file’s 
name also appears in the Material Properties Browser. 

You can display either small or large texture samples in the Material Browser list. 
To display the small samples, right-click on one and select Small Previews from 
the pop-up menu. To display the large texture samples, right-click on one and 
select Large Previews from the pop-up menu. 

4. Make further decisions in the Material Properties Browser and the Color 
Picker to refine the appearance of the texture. 

 
Figure 4.10: Selecting the granite texture affects the appearance of the counters 
and the floor tiles in the Player Window as well as the contents of the Material 
Properties Browser and the Color Picker.  
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Material Properties Browser 
The Material Properties Browser gives you additional control of the materials 
that you specified in the Material Browser. 

When you apply a texture to an object, more options become available in the 
Material Properties Browser than is the case with objects that cannot receive 
textures. Objects that can receive textures can also assume a new color that can be 
visible through the texture. 

 To change the properties of a textured material in the Material Properties 
Browser: 

1. Do not change the Render backface option unless surfaces appear to be 
missing from the object. Check the Render backface option to render both 
sides of a surface. Only check this option when necessary since it will 
increase the time to render your project. 

• Decide whether an object should provide its own illumination. This is 
useful for low-level light sources such as neon; however, you can 
check the Self-illuminate option for  any materials. 

2. Decide whether to make the texture dominant or let a color show through 
the texture. 

• Make the black areas of a texture appear as voids by checking the 
Texture masks object box. 

• Let the color mix with the texture by checking the Mix texture with 
rendered color box. If you select this option, use the Color Picker to 
experiment with colors. 

 
Figure 4.11: The honey yellow shade lightens the wood texture of the cabinets. 

3. Decide whether to reflect the texture on the surface by checking Apply 
texture as reflection map box.  
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• If you select this option, the texture will appear as if it were being 
reflected on the surface. This option is useful for simulating shiny 
metal such as brushed aluminum or stainless steel.  

• If you want to control the shine, you can click on the Matte, Glossy, or 
Glass buttons. When you click on one of these buttons, you also affect 
the slider bar values for Ambient, Diffuse, Reflection, Opacity, and 
Refractive Index. 

4. Decide whether to change the file that controls the texture. If you have a 
BMP or JPEG file you would like to substitute, click on the folder icon in 
the Material Properties Browser. The Load Texture dialog box appears. 
You can browse through the BMP and JPEG files to preview a new 
texture. Just click on Open or press [Enter] to make it take effect in your 
Player Window. 

The scale of a texture is determined by the original author of the object and 
cannot be changed in o2c_Interactive!. The resolution of a texture has no effect 
on its scale. 

 
Figure 4.12: When you browse through the BMP or JPEG files available from 
various sources, you may find a texture that you like. 

The slider bars in the Material Properties Browser give you direct control of 
several aspects of the project in the Player Window. 

 To enhance material properties by using the slider bars: 

1. Click on the square for the material properties value you want to change. 
The square blinks until you click on a different slider category. 

2. Drag the bar and watch the effect it has on the project in the Player 
Window. Alternatively, you can use the [Left Arrow] key or the button on 
the left of a slider bar to decrease the value; use the [Right Arrow] key or 
the button on the right of a slider bar to increase the value. 

3. Use a combination of values to produce the effect you want. 

• Ambient Increase this value to simulate plastic 

• Diffuse Decrease this value to simulate velvet 
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• Reflection Increase this value to simulate glossy surfaces 
such as chrome 

• Opacity Increase this value to simulate transparent 
materials such as glass 

• Refractive Index Less than 10 simulates water; 10 equals air; more 
than 10 simulates glass 

Changing Colors 
You can use either the Material Browser color palette or the Color Picker to 
change the color of an object. 

Using the Material Browser for Color Change 

 To change an object’s color in the Material Browser: 

1. Display the materials list (make sure the first icon in the Material Browser 
is active). Then, highlight the item you want to change. Alternatively, you 
can click on the item you want to change in the Player Window to 
highlight the appropriate material in the Material Browser list. 

2. Click on the color icon (the fourth icon from the left in the Material 
Browser). The 255-color custom palette appears. 

3. Right-click within the palette to display the three color types and check 
the one you want to use: 

• DataCAD 

• DXFDWG 

• Prizma 

4. Use the slider bar to display more swatches within the color palette you 
selected. 

5. Click on the color swatch you want to use on the item(s) you highlighted 
in step 1. 
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Figure 4.13: The Prizma color palette is displayed in the Material Browser. 

When you select a color from the Material Browser, you can see its values 
displayed in the Color Picker. 

Using the Color Picker for Color Change 

 To change an object’s color in the Color Picker: 

1. Select the object you want to work with in the Player Window or from the 
Material Browser’s material list. 

2. Click the color you want on the cube in the Color Picker. If you want to 
see more options, right-click and drag on the cube to reveal other faces. 
The color you selected appears on the object(s) in the Player Window and 
in the bottom left color swatch, next to the swatch that shows the old 
color.  

3. Use the slider on the right side of the Color Picker to further refine the 
color. The slider helps adjust a color’s brightness. 

 
 

Figure 4.14: The Color Picker 
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The red, green, and blue color values are displayed in the input boxes at the 
bottom of the Color Picker. 

Copying and Pasting Color Definitions for Materials 
You can use a material definition from one object and apply it to another by 
using the copy and paste functions available in the Material Browser. 

 To copy a material definition from the Material Browser list: 

1. Highlight the cube (leftmost) icon to display the list of objects. 

2. Click on the object in the list that you want to copy. 

3. Right-click to reveal a pop-up menu. 

4. Select Copy Material from the pop-up menu. 

 
Figure 4.15: Right-click and select Copy Material from the pop-up menu. 

 To paste a color definition you copied onto another object in the Material 
Browser list: 

1. Highlight the cube (leftmost) icon if it isn’t already selected. 

2. Click on the object in the list that you want to receive the material 
definition you copied in the previous set of steps. 

3. Right-click to reveal a pop-up menu. 

4. Select Paste Material from the pop-up menu. o2c _Interactive! pastes the 
definition onto the object you highlighted in step 1. 
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If you selected an item that contains texture definitions, only the color definition 
will be pasted onto the second object. The texture definitions cannot be copied 
and pasted.  You can also use the keyboard shortcuts [Ctrl] + [C] for copy and 
[Ctrl] + [V] for paste for the material definition. 

Controlling Lights 
In a design scheme, lighting is an important element. There are six lighting 
effects on the icon toolbar. In addition, there is the Self-illuminate option in the 
Material Properties Browser, which we have already discussed. So, let’s look at 
what the toolbar light icons can do. 

 

 
 

Figure 4.16: Light icons 

These six icons are toggle switches that turn a lighting effect on or off. You can 
activate several of these toggles simultaneously. 

• Sun – toggles sunlight on and off 

• Ambient lights 1, 2, and 3 – toggles ambient lighting on and off 

• Lamp – toggles interior lighting on and off 

• Sun/moon – switches between day and night lighting 

The sunlight (leftmost) and day/night (rightmost) icons control external light 
sources. The most dramatic change occurs when you toggle between day and 
night lighting because the background changes to either a blue or starlit sky 
respectively. The sunlight icon works when the day/night icon is switched to the 
day option to show what the interior would look like on a sunny or cloudy day. 

The three ambient lights and the lamps icon affect the brightness of the interior. 
These four light sources can either be turned on simultaneously or toggled on or 
off separately to produce different effects.  

Updating a Scheme 
When you have made changes to a scheme, you should update it. It is also a 
good idea to check the list in the Material Browser and study the refinements 
indicated in the Material Properties Browser for each type of item in the current 
scheme. 

 To update and save changes you made to a scheme: 

1. Make changes to a scheme. 

2. Select Save from the Scheme pull-down menu. The changes you made to 
the scheme are saved. 

Sunlight 

Ambient light #1 

Ambient light #2

Ambient light #3

Lamps 

Day or night 
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Locking and Unlocking a Scheme 
You can lock a scheme to preventmaking alterations. Later, you can unlock the 
scheme for internal use. 

 To lock a scheme: 

1. Click on the scheme you want to lock in the Schemes portion of the 
Views/Schemes Browser. 

2. Right-click to display a pop-up menu. 

 
Figure 4.17: Lock Scheme 

3. Select Lock Scheme. A padlock appears in front of the scheme you locked. 

 To unlock a scheme: 

1. Click on the padlock in front of the scheme you want to unlock in the 
Schemes portion of the Views/Schemes Browser. 

2. Right-click to display a pop-up menu. 



| CHAPTER 4: DEVELOPING SCHEMES  42 

 
Figure 4.18: Unlock Scheme 

3. Select Unlock Scheme. The padlock disappears from the Views/Schemes 
Browser. 

Raytracing 
To see the way color, texture, and material definitions affect the appearance of 
your project, you can use raytracing. Raytracing renders the model in your 
Player Window. 

Depending on the complexity of your project, the number of design elements, 
and the processing speed of your computer, raytracing can take several minutes. 
Once you start raytracing, you can press [Esc] to halt the procedure.  

 To raytrace your project: 

• Click on the Raytrace icon on the Toolbar. 

Or 

• Click on the [R] button in the lower left corner of the Controlbars. 

Batch Rendering 
You can render several views simultaneously. Since this may take a lot of time 
(depending on the number of views, their complexity, and your computer’s 
processing speed), you could schedule this to occur after office hours.  

 To render a group of views simultaneously: 

1. Select Batch Render from the File pull-down menu. The Batch Rendering 
dialog box appears. 
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2. Check the views that you want to render; remove the check from views 
you do not want to render. Since o2c_Interactive! assumes that you want 
to render everything, it checks all the views. The Select all button checks 
all boxes; the Clear all button removes the checkmark from all boxes. 

3. Set the width and height in pixels for the final images in the input boxes. 
The higher the value, the greater the resolution or detail and the longer it 
will take to render the views. 

4. Decide on the level of output quality you want: Low, Medium, or High. 
The Low, Medium, and High settings affect how much sampling will 
occur during rendering to smooth the edges of polygons. In most cases, a 
setting of Low or Medium is sufficient to produce a high-quality image. 
The High setting should be used rarely because it can greatly increases 
the time to render (an hour or more in some cases) and achieves only a 
slightly better result than the Medium setting. 

5. Check the Raytrace box if you want to render the views with shadows 
and reflections. Remember that raytracing will require more time. 

6. Select the Output format you prefer from the drop-down options: BMP, 
JPG, PNG, TGA, TIFF, or PCX files. 

7. Click on <New> in the Batch Name drop-down box, choose the Save 
button to display the Batch Session Name dialog box, supply a name in 
the input box. Use only the upper- or lower-case letters, the numbers 0 
through 9, and/or spaces for the view name. Do not use any punctuation 
marks.  

8. Click on OK or press [Enter].  

 
Figure 4.19: The Batch Session Name dialog box 

 You can have several different batch session names that contain one or 
more views. For each batch name you want to add, click on <New>, 
choose the Save button, supply a name, and press [Enter]. If you want to 
change the options that apply to one of the batches, select the name from 
the pull-down list, and click on Save. If you want to delete one of the 
options from the Batch Session Name drop-down box, select the name 
and click on Delete. 
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Figure 4.20: The Batch Rendering dialog box 

9. Click on OK to start rendering all the views you checked in the batch.  

 



 

Fine-tuning o2c_Interactive! 
Going beyond the basics lets you further control your design 
project with o2c_Interactive!. For example, you can walk 
through your project to see it from different angles or create a 
slideshow. 

The View Manager lets you control your project to coordinate 
design schemes, backgrounds, and views. Publishing your 
project on the internet lets clients download your designs. 
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Setting Default Options for o2c_Interactive! 
You can customize the way the o2c_Interactive! backgrounds appear in your 
Player Window. For example, you may have special “wallpaper” that features 
your company’s logo that you would prefer. 

 To customize program options: 

1. Select Program Options from the File pull-down menu. The Program 
Options dialog box appears. 

2. Set the daytime/nighttime background options you prefer. 

• Enable Day/Night Background Color/Image - If you want a constant 
background that doesn’t change whether it is day or night, click in the 
box to remove the default checkmark.   

• Daytime Background Color/Image – Click on the color swatch to display 
the Color dialog box. Select the color you prefer from the Basic Color 
samples or click within the color spectrum square and/or drag the 
hue slider bar. The shade you selected appears in the Color Solid box. 
Click on OK or press [Enter] when you are satisfied with the color. 
The Color dialog box closes and the color you selected appears in the 
daytime swatch in the Program Options dialog box.  

 
Figure 5.1: The Color dialog box 

Click on the folder icon to display the Select Daytime Background 
Image dialog box. Select the image you prefer from those offered in 
the Background folder or open a different folder on your computer 
that contains .BMP or .JPG files that you prefer. For example, you may 
have your company’s logo embedded on a daytime sky background. 
When you are satisfied with the background that appears in the 
Preview window, click on Open or press [Enter]. The dialog box 
closes and your selection appears in the file input box in the Program 
Options dialog box. If you do not want a daytime background image, 
delete the file name from the input box. 
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Figure 5.2: The Select Daytime Background Image dialog box 

• Nighttime Background Color/Image – Click on the color swatch to 
display the Color dialog box. Select the color you prefer from the 
Basic Color samples or click within the color spectrum square and/or 
drag the hue slider bar. The shade you selected appears in the Color 
Solid box. Click on OK or press [Enter] when you are satisfied. The 
color you selected appears in the nighttime swatch in the Program 
Options dialog box. 

Click on the folder icon to display the Select Nighttime Background 
Image dialog box. Select the image you prefer from those offered in 
the Background folder or open a different folder that contains .BMP 
or .JPG files that you prefer. When you are satisfied with the 
background that appears in the Preview window, click on Open or 
press [Enter]. Your selection appears in the file input box in the 
Program Options dialog box. If you do not want a nighttime 
background image, delete the file name from the input box. 

3. Select the Alternate Texture Path you prefer by clicking on the folder icon 
to display the Alternate Texture Folder dialog box. Click on the folder 
that contains texture files you want to use. Press [Enter] or click on OK to 
close the Alternate Texture Folder dialog box. The folder you selected 
appears in the Alternate Texture Path input box.  

 
Figure 5.3: Select a folder that contains texture bitmap files you want 
o2c_Interactive! to use.  
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4. Choose a different Highlight Color by clicking on the swatch to display 
the Color dialog box (see Figure 5.1).  

5. Set a new Rotation Speed for the navigation cursor by clicking on the 
increase/decrease arrows. The greater the value, the faster the rotation.  

6. Decide whether you want to hide undocked toolbars when the 
o2c_Interactive! application is inactive. If you do not want to hide them, 
make sure there is no checkmark in the box in the Undocked Toolbars 
portion of the Program Options dialog box. For example, if you reduce 
the size of the o2c_Interactive! screen and move the undocked toolbars to 
your desktop, you can click on the desktop to inactivate the program and 
hide the undocked toolbars. This allows you to switch to another 
application on your desktop without worrying about the clutter of the 
undocked o2c_Interactive! toolbars.  

7. Press [Enter] or click on Ok when you are satisfied with all your 
selections in the Program Options dialog box. These decisions will take 
effect as o2c_Interactive! defaults. 

 
Figure 5.4: Program Options dialog box 

If you supplied a file name for either the daytime or nighttime background, the 
image you selected will appear in the background of your design when you click 
on the Day/Night icon on the Lights Toolbar. If you supplied both a color and 
file name for the daytime or nighttime background, the image is dominant and 
will appear in the background. 

 To temporarily use the daytime or nighttime background color instead of the 
dominant background image: 

1. Right-click in the background portion of the Player Window. A menu 
appears. 
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Figure 5.5: Right-click on the background in the Player Window to display this 
menu. 

2. Select Background . . . from the menu. The Background dialog box 
appears. Notice that the Background picture option is activated. 

3. Click in the radio button before Monochrome. 

 
Figure 5.6: Select Monochrome if you want the background to display a color 
instead of a picture or image. 

4. Click on OK or press [Enter]. The background in the Player Window is 
the color you designated when you customized the o2c_Interactive! 
program defaults. 

This is not a permanent change; it affects only the current view of your project. 
The next time you click on the Day/Night icon in the Lights Toolbar, the 
background image will once again take precedence. To permanently display a 
background color rather than an image, you must delete the file name(s) in the 
input boxes for Daytime Background Color/Image and Nighttime Background 
Color/Image. 

Walking Through Your Design 
With the Walk Through option, o2c_Interactive! lets you tour the project. You 
can walk toward or away from the design, turn right or left, step up or down or 
to one side, or look up or down or to one side.  

 To walk through your design: 

1. Prepare your design for the walk through by clicking on either the 
Isometric or Axonometric icon cube in the View Toolbar. 
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2. Select the navigation cursor icon and use it to position yourself for the 
walk through. Use the rotating feature or right-click and drag up or down 
until you are ready to start the walk through. 

3. Right-click within your project to display the menu shown in Figure 5.5. 

4. Click on Walk through. The navigation cursor changes so that you can 
tour your project with the aid of your mouse and the keyboard. 

5. Move your cursor to the middle of your Player Window until it changes 

to . 

6. Use the [Arrow], [Shift], and [Ctrl] keys to move around your design.  

• [Up Arrow] moves forward 

• [Down Arrow] moves backward 

• [Right Arrow] moves to the right 

• [Left Arrow] moves to the left 

• [Shift] + [Arrow] moves at a slower rate 

• [Ctrl] + [Arrow] moves at a faster rate 

• [Ctrl] + [Shift] + [Arrow] moves even faster 

Using the walk through function requires practice. Try walking through a simple 
room to experiment. 

Depending on your cursor’s position within the Player Window, it will assume 
one of these shapes: 

 lets you move in different directions 

lets you rotate your position 

lets you go forward, backward, right, or left with the [Arrow] keys 

Working with Saved Views 

Customizing Saved Views 
You can control the views and associate them with specific schemes and 
backgrounds with the View Manager. 

 To customize saved views: 

1. Select View Manager from the View pull-down menu. The View Manager 
dialog box appears. Views that you created are listed in the box. 
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Figure 5.7: The View Manager dialog box 

2. Highlight the view you want to customize. 

3. Decide how you want to customize the view using these options: 

• View – You can rename the currently selected view. In the View input 
box, delete the old name and type the new. Use only the upper- or 
lower-case letters, the numbers 0 through 9, and/or spaces for the 
view name. Do not use any punctuation marks. Press [Enter] to make 
this change appear in the View Manager’s list box. 

• Scheme – Select the scheme you want to associate with the highlighted 
view from the options available in the drop-down box.  

• Background Image or Background Color – These two options are 
mutually exclusive. If no name appears in the background image 
input box, o2c_Interactive! uses the color in the swatch as the view’s 
background. To choose a different background color, click on the 
swatch and make your selection from the Color dialog box (see Figure 
5.1).  

If a name appears in the background image input box, it takes 
precedence. Click on the folder icon and use the Select Background 
Image for View dialog box to browse for an appropriate .BMP or .JPG 
file to use as a background image.  

 
Figure 5.8: Browse through folders to select a background image .BMP or .JPG file. 
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4. Repeat steps 2 and 3 for each view in the list that you want to customize. 

5. Reposition a view in the list by highlighting it and clicking the Move Up 
or Move Down buttons until you are satisfied. Repeat this for other views 
you want to move up or down in the list. 

6. Click on OK when you have finished making changes in the View 
Manager dialog box. 

Deleting a View 
If you want to eliminate a view you have created, you need to use the View 
Manager. You can also use the context menu in the Views/Schemes Browser to 
delete a view. 

 To delete a view: 

1. Select View Manager from the View pull-down menu. The View Manager 
dialog box appears. Views that you created are listed in the box. 

2. Highlight the view you want to delete. 

3. Click on the Delete View button in the View Manager dialog box. The 
view disappears from the View Manager’s list immediately, but it is still 
visible in the Views/Schemes Browser. 

4. Click on OK. Now, the view you deleted in step 3 disappears from the 
Views listing in the Views/Schemes Browser.  

As you can see by comparing figures 5.7 and 5.9, we eliminated one view and 
rearranged the remaining ones. 

 
Figure 5.9: Compare this with Figure 5.7 to see how Views were repositioned or 
deleted from the current design project. 
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Publishing to a Website 
The designs you created using o2c_Interactive! can be published to a website so 
that your clients can view them and decide whether they want changes. You can 
publish views and/or schemes or images or both. Also, when you create a 
slideshow based on your designs, you can set the time between slides.  

Publishing Views and Schemes to a Website 
You can publish selected views and schemes to a website. All the views and 
schemes you created in your design project appear in the Publish to Web dialog 
box. Initially, all of the views and schemes are selected because there is a 
checkmark in each box that precedes a view or scheme name. 

 
Figure 5.10: The Publish to Web dialog box 

 To publish selected views and schemes to a website: 

1. Select Publish to Web from the File pull-down menu. The Publish to Web 
dialog box appears. 

2. Click on the Views/Schemes button in the Publish section of the dialog 
box. The Views and Schemes sections are activated; the rest of the options 
are grey or unavailable. 

3. Make sure that checkmarks appear in front of all the views and/or 
schemes that you want to publish. Remove checkmarks from other views 
and/or schemes by clicking in the box. If you change your mind, simply 
click in the box again to make the checkmark appear. 

4. Change the values in the Width and Height input boxes to indicate the 
pixel size you want to appear on the website. 

5. Click on the Publish button at the bottom of the dialog box. The Save As 
dialog box appears. 
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6. Provide a name for the HTML file. 

 
Figure 5.11: Provide a name for the HTML file you want to publish to a website. 

7. Click Save or press [Enter]. In a few moments, the views and images 
appear in a website presentation screen.   

 
Figure 5.12: The website presentation screen. 
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8. Scroll down using the elevator bar on the website presentation screen to 
display the view and scheme names you published. If you provided more 
than one view and scheme in your presentation, your client will be able to 
experiment with the different design alternatives. Clicking and moving 
the mouse in the presentation window displays the navigation cursor that 
lets the client turn the design. Right-clicking and dragging the mouse 
forward or backward enlarges or shrinks the image. 

 
Figure 5.13: The choice of views and schemes displayed at the bottom of the 
presentation window allows the customer to see different design alternatives. 

9. Right-click in the presentation window to display a menu of options that 
your client can use. The most useful options are: 

• Save image – In the Save bitmap screen that appears, your client can 
save the presentation to a folder on his/her own computer or 
network.  

• Start raytrace – This produces a rendered image complete with 
reflections and shadows. See “Raytracing” in Chapter 4 for more 
information.  

• Background – The Background dialog box appears, allowing your 
client to change the color or image behind the design project. See 
“Changing the Background” in Chapter 3 for more information.  
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• Display mode – Your client can change to Wireframe or other modes. 
The o2c_Interactive! images are originally shown in the 
Shaded/textured display mode. See “Changing the Display Mode” in 
Chapter 3 for more information.  

• Walk through – This lets your client tour the design. See “Walking 
Through Your Design” in this chapter for more information.  

      
Figure 5.14: This menu appears when you right-click in the presentation window. 

Publishing a Slideshow of Images to a Website 
You can publish images to a website in much the same way as views and/or 
schemes; however, this involves other portions of the Publish to Web dialog box. 
These images will form a slideshow that your client can see on the web. 

 To publish a slideshow of images to a website: 

1. Select Publish to Web from the File pull-down menu. The Publish to Web 
dialog box appears. 

2. Click on the Slideshow button in the Publish section of the Publish to 
Web dialog box. The File and Slide Label sections are activated. The 
Views and Schemes sections are grey or unavailable. 

3. Click on the + button on the right side of the Publish to Web dialog box. 
The Select one or more files . . . dialog box appears. 
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4. ***Choose the image file(s) you want to publish to a website. Use the 
Look in drop-down box or the Up one level folder icon to help you find 
the file(s). Notice that the Files of type drop-down box offers several 
choices: Windows Bitmap (BMP), JPEG or Joint Photographic Experts 
Group (JPG), Portable Graphics (PNG), Targa (TGA) , Tagged Image File 
Format (TIFF) , Paint Shop Pro (PCX) , and Kodak Photo CD (PCD) . To 
select several consecutive files, hold down the [Shift} key while you click 
on the first and the last in the series. To select several random files, hold 
down the [Ctrl] key while you click on the different ones. Click on Open 
or press [Enter] to return to the Publish to Web dialog box. Notice that the 
file(s) you selected appear in the File (which contains the complete path) 
and the Slide Label (which contains only the name) sections of the 
Publish to Web dialog box. 

You can select image files from just one folder at a time. If you want to 
select files from several different folders, you must repeat steps 3 and 4 as 
often as necessary. Select as many images as you want. If you go beyond 
six, you can use the controlbar to see the other files. 

 
Figure 5.15: These two files were selected by depressing the [Ctrl] key while 
clicking on the file names. 

5. Rearrange or delete image files from the list with the buttons on the right 
side of the Web Publishing dialog box. The – button lets you eliminate 
unwanted images from the list. The up and down arrow buttons let you 
rearrange the sequence of images. (For example, you may want to move 
the Sky_Night file below the Michigan file with the down arrow button 
and totally eliminate the Gravel file with the - button.) 
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Figure 5.16: Image files from several different folders are included in the list. 

6. Select BMP, JPG, or PNG from the Output type drop-down box. This 
controls the file type of the slideshow. Even if many of your image files 
are bitmaps, you can produce the slideshow as JPEGs or Portable 
Graphics. 

7. Use the Slide Delay box to indicate the number of seconds between 
images.  

8. Click Uniform slide proportions to place a checkmark in the box and to 
activate the options in the Slide Proportions portion of the Publish to Web 
dialog box. Making all slideshow images a uniform size will be more 
appealing to your clients. Click on one of the three round buttons and 
supply the pixel measurement(s) to indicate the size of all the images in 
your slideshow. 

• Uniform Width – All images will be the same width, but their heights 
may vary. 

• Uniform Height – All images will be the same height, but their widths 
may vary. 

• Uniform Width and Height – All images will be exactly the same width 
and height. 
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Figure 5.17: The slides will all be 640 X 480 pixels and appear at 8-second intervals. 

9. Click on the Publish button when you are satisfied with your choices. The 
Save As dialog box appears. 

10. Supply a name in the input field and press [Enter] or click on Save. The 
images appear in the My Slideshow window. Notice that the slideshow’s 
file name appears in the Address box.  

11. Press the Start button to run the slideshow automatically or use the arrow 
buttons to go backward or forward one slide at a time or to the end or 
beginning of the show. Use the Stop button to halt the show. Use the pull-
down box to select the image you want to display.  
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Figure 5.18: The slideshow of images is ready to roll. 

You can create a slideshow with both views and schemes from the upper portion 
of the Publish to Web dialog box and images from the lower portion. To do this, 
just click on the Both button in the Publish portion. 
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defaults, 50 
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color definitions of materials, 42–43 

setting defaults for, 50–51 Cursors 
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permanently, 54 
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select, 13 
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Customizing o2c_Interactive!, 50–54 
raytracing during, 47 Alternate Texture Path option, 52 
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bitmap, 23, 39, 47, 56, 63, 64 
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Color/Image option for background, 50 

HTML, 59 
JPEG, 39 

Hide inactive undocked toolbars option, 
52 
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Group, 56, 63, 64 

Hightlight Color option, 52 JPEG or Joint Photographic Experts 
Group, 47 Nighttime Background Color/Image 

option for background, 51 Kodak Photo CD, 47, 63 
Rotation Speed option, 52 o2c objects, 9 
setting day/night background, 50 Paint Shop Pro, 47, 63 

DataCAD LLC Portable Graphics, 63 
contact for technical support, 3 Portable Network Graphics, 47, 64 

Default settings, 50–54 Tagged Image File Format, 47, 63 
Deleting views Targa, 47, 63 

with View Manager, 57 File types for slideshow output 
Design file BMP, JPG, or PNG, 64 

opening, 9–10 Finishes for surface 
Dialog box Glass, 34 

Add View, 20 Glossy, 34 
Alternate Texture Folder, 52 Matte, 34 
Background, 21, 23, 53 Folder icon 
Batch Rendering, 46 in Material Browser, 34, 36 
Batch Session Name, 47 in Material Properties Browser, 39 
Color, 50 in Program Options, 50, 51, 52 
Color palette, 22 Glass 
Load background image, 23 button in Material Properties Browser, 39 
Load Object, 9 finish for surface of material, 34 
Load Texture, 39 Glossy 
Material Folder, 34 button in Material Properties Browser, 39 
Material Name, 32, 33 finish for surface of material, 34 
Program Options, 50, 51 Help 
Publish to Web, 59, 66 contact DataCAD for technical support, 3 
Save As, 59, 65 Installing o2c_Interactive!, 4–6 
Save As Scheme, 31 pre-installation checklist, 5 
Select Background Image for View, 56 setup program, 6 
Select Daytime Background Image, 51 system requirements, 5 
Select Nighttime Background Image, 51 Isometric view, 19 
Select one or more files, 63 Lamp icon 
Texture Folder, 36 in Lights toolbar, 44 
Update View, 20 Lighting 
View Manager, 55, 57 indoors, 44 
Web Publishing, 62 outdoors, 44 

Diffuse Lights 
slider in Material Properties Browser, 39, 

40 
Ambient icons, 44 
ambient lighting on/off, 44 

Display mode, 25–26 controlling, 44 
changing, 25 day/night toggle, 44 
default for o2c_Interactive!, 25 exterior, 44 
types of, 25 icon toolbar, 13, 44 

Displaying interior on/off, 44 
entire project with Controlbars, 27 producing effects with, 44 
list of views, 20 self-illuminate in Material Properties 

Browser, 44 Elevation views, 19 
Fields of view, 19 Sun icon, 44 
File menu Sun/moon icon, 44 

controlling toolbars from, 13 sunlight on/off, 44 
Open - new, 9 LightsLamp icon, 44 
Publish to Web, 59, 62 Material 
Re-Open - existing, 9 changing appearance of, 37 

File types changing pre-defined finish for, 34 
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clearing the name of a, 33 Opening 
editing the name of a, 33 a new file, 9 
eliminating the name of a, 33 an existing file, 9 
in Material Browser, 32 design file, 9–10 
list of active, 32 Orthographic view, 19 
naming a, 32 Parallel view, 19 
pre-defined finish for, 34 Pasting 

Material Browser, 30–37 color definitions of materials, 42–43 
changing color with, 40–41 Perspective view, 19 
color icon, 41 Picture 
color palette in, 41 tiling in background, 24 
color value displayed in Material Color 

Picker, 41 
using as background, 23 
using copies of in background, 24 

displaying list of active materials in, 32 Plan view, 19 
finishes icon, 34 Player Window, 10 
icon toolbar in, 30 Publishing to a website 
material icon, 32, 34, 35 height of view in pixels, 59 

presentation screen, 60. See Website 
presentation screen 

naming a material in, 32 
pre-defined finish for material, 34 
texture icon, 35 views and schemes, 58–62 
using to copy or paste color definitions, 

42–43 
width of view in pixels, 59 

Raytrace, 19 
using with Material Properties Browser, 

30–43 
icon in Views toolbar, 46 

Raytracing, 46 
Material Properties Browser, 30, 37–40 can't halt this procedure, 46 

Ambient slider, 39, 40 saving time during, 37 
Apply texture as reflection map option, 38 with Controlbars, 27, 46 
changing a textured material, 37 with Raytrace icon, 46 
Diffuse slider, 39, 40 Reflection 
Glass, 39 slider in Material Properties Browser, 39, 

40 Glossy, 39 
Matte, 39 Refractive Index 
Mix texture with rendered color option, 38 slider in Material Properties Browser, 39, 

40 Opacity slider, 39, 40 
Reflection slider, 39, 40 Render, 19 
Refractive Index slider, 39, 40 batch of views, 46–48 
Render backface option, 37 Render backface 
Self-illuminate option, 38, 44 saving time by unchecking, 37 
Texture masks object option, 38 Re-Open a file, 9 
using slider bars in, 39 Reset icon 
using with Material Browser, 30–43 restoring previous material properties 

with, 13, 30 Matte 
button in Material Properties Browser, 39 Rotate view, 19 
finish for surface of material, 34 setting default speed for navigation 

cursor, 52 Navigation cursor 
setting default rotation speed for, 52 Saving 

o2c_Interactive! screen view changes, 20 
browsers, 14 views, 20 
Color Picker, 16 Scheme 
icon toolbar, 13 adding and naming in Views/Schemes 

Browser, 31 information toolbar, 13 
Material Browser, 14 associating with a view in View Manager, 

56 Material Properties Browser, 15 
menu bar, 11 changing, 32, 45 
Player Window, 10 locking, 45 
toolbars, 11 unlocking, 46 
tour of, 10 updating, 32, 45 
Views/Schemes Browser, 14 Scheme menu, 30 
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Save option, 32, 45 undocking, 12 
Schemes option, 32 Views, 13 

Schemes, 30–48 View Manager, 55–58 
coordinating with background. See View 

Manager 
associating the current view with a 

background image or color, 56 
coordinating with views. See View 

Manager 
associating the current view with a 

scheme, 56 
option in Scheme menu, 30 Background Image or Color option, 56 
publishing to a website. See Publishing to 

a website, views and schemes 
background image takes precedence over 

color, 56 
using Material and Material Properties 

browsers for, 30–43 
Delete View button, 57 
Move Down button, 57 

Self-illuminate Move Up button, 57 
in Material Properties Browser, 38 moving views within the list, 57 
simulate a light source, 38 renaming the current view, 56 

Setup program, 6 Scheme option, 56 
Slideshow View option, 56 

delay time between slides (in seconds), 64 View menu 
making all slides the same size, 65 Add View, 20 
output type (BMP, JPG, or PNG), 64 Update View, 20 
Slid Proportions options, 65 View Manager, 55, 57 
speed of (in seconds), 64 Views 
Uniform slide proportions option, 65 axonometric, 19 

Standard changing with navigation cursor, 18 
controlling, 19–21. See View Manager icon toolbar, 13 
coordinating with background. See View 

Manager 
Starting o2c_Interactive!, 8 
Sun icon 

coordinating with schemes. See View 
Manager 

in Lights toolbar, 44 
Sun/moon icon 

in Lights toolbar, 44 customizing saved, 55–57 
Support deleting with View Manager, 57–58 

contact DataCAD for help, 3 displaying list of, 20 
Switching views, 21 elevations, 19 
System requirements, 5 fields of view, 19 
Technical support, 3 icon toolbar, 13, 19 
Textures isometric, 19 

applying to materials, 35–37 orthographic, 19 
changing color of in Color Picker, 36 parallel, 19 
changing in Material Properties Browser, 

36 
perspective, 19 
plan, 19 
publishing to a website. See Publishing to 

a website, views and schemes 
changing properties of, 37 
color not visible through, 38 
color visible through, 37, 38 raytrace, 19 
controlling shiny surface of, 39 renaming with View Manager, 56 
masking color of objects with, 38 render with shadows and reflections, 19 
samples of in Material Browser, 36 saving, 20 
setting path defaults for available, 52 saving changes, 20 
shiny surface with reflection map, 38 selecting from Views menu, 21 

Tiling background picture, 24 switching to different, 21 
Time saving using, 18–27 

uncheck Render backface option, 37 Views menu 
Toolbars, 11–16 Views, 21 

displaying, 13 Views/Schemes Browser, 30 
docking, 12 <None> in list of schemes, 30, 31 
dragging, 12 adding a scheme to, 31 
hiding, 13 list of schemes in, 30 
hiding undocked when inactive, 52 list of views in, 20 
Lights, 13, 44 Walk through design, 54–55 
moving, 12 using keyboard to, 54 
repositioning, 12 Website presentation screen 
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background option, 62 Website slideshow screen 
display mode option, 62 arrow buttons, 66 
displaying views and schemes on, 61 displaying only one image, 66 
enlarging images in, 61 image drop-down box, 66 
right-clicking for options menu in, 61 playing slides on, 65 
save image option, 61 Start button, 66 
shrinking images in, 61 Stop button, 66 
start raytrace option, 61 Zooming 
using navigation cursor in, 61 with Controlbars, 27 
walk through option, 62 with navigation cursor, 18 
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